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wOHlaI ckrd,a;=ñhf.a m‚úvh

Y%S ,xldfõ idudkH wOHdmk mßj¾;kSh m%;sixialrK m%h;akh ieu bf.kqï 

,dNshl=f.a u wjY;d imqrd,Su i|yd msrKd;aul udj;la wruqKq lr we;'

ksmqK;d mdol bf.kqu" úpdrd;aul Ñka;kh" ks¾udK YS,s;ajh" 21 jk ishj-

fia l=i,;d" ;dlaI‚l keUqrej" iodpdrd;aul mqrjeis Ndjh jeks fndfyda wxY 

wjOdrKh lsÍug yels jk mßÈ úIh ud,dj" bf.kqï - b.ekaùï ;=u iy mla-

fiare ms<sfj;a hkdÈh NdùlrKh fuu m%;smxialrK l%shdj,sfhys mokï úh'

wOHdmk{hska" wka;¾h ffjIhsl úoaj;=ka" .=rejreka iy úúO md¾Yaj lrejka 

iuh iyfhda.S ixjdohla yryd cd;sl wOHdmk wdh;kh úiska 2026 j¾Ifha 

isg 16 fY%a‚j, l%shd;aul lsÍug fhdað; úIhud,d yd wod< bf.kqï øjHj, 

.=Kd;aul nj iy;sl lsÍu i|yd úfYaI Wkkaÿjla f.k lghq;= l< .re 

w.%dudlH;=ñh' wOHdmk f,al;=ud" wOHdmk wud;HdxYfha w;sf¾l f,alïjre-

ka" úIh Ndr ,OdÍka" úNd. flduidßia ckrd,a yd ld¾h uKav,h" wOHdmk 

m%ldYk flduidßia ckrd,a yd ld¾h uKav,h oelajQ odhl;ajh w;s uy;ah'

tfukau" fuu ld¾hfha § iqúfYaI lemùula isÿ l< cd;sl wOHdmk wdh;kfha 

md,l iNdfõ yd Ydia;%Sh lghq;= uKav,fha lemùu o f.!rj mQ¾jl ia;=;sfhka 

isysm;a lrñ'

fuu ld¾hh idlaId;a lr .ekSug buy;a f,i lem jQ cd;sl wOHdmk wdh;k-

fha ish¨ ld¾h uKav,hg cd;sfha f.!rjh ysñ úh hq;= nj i|yka lrhs'

uydpd¾h uxcq,d ú;dkm;srK

wOHlaI ckrd,a

cd;sl wOHdmk wdh;kh
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fmrjok

iuia; mdi,a úIhud,dj i|yd y÷kdf.k we;s mq¿,a bf.kqï lafIa;%"  

ksrka;rfhka fjkia jk rgl iy f,dalhl" ;srir ixj¾Okh flfrys jk 

wNsfhda. ch .ekSug tu cd;shg we;s yelshdj ms<sìUq lrhs'  tfuka u l,ska 

l,g fjkia jk b,a¨ïj,g .e<fmk fia  mq¿,a bf.kqï lafIa;% o y÷kd 

f.k we;' fuu.ska mj;sk mdi,a úIhud,dj ;=< jQ úIhhka kùlrKh jk 

w;r u kj úIhhka mdi,a úIhud,djg y÷kajd §u isÿ flf¾' fuu isÿ jk 

fjkialïj,g wkqrEm j bf.kqï-b.ekaùï l%shdj,sh o ld,dkqrEm j ixj¾Okh 

úh hq;= nj meyeÈ,s h' fuys m%;sM,hla f,i 6 fYa%Ksfha isg by<g 2026 j¾Ifha 

isg l%shd;aul jk kj úIhud,dj i|yd iEu úIhhlg u bf.kqu mdol 

fudähq, y÷kajd § we;' 2026 j¾Ifha § 1 iy 6 fY%aKs i|yd;a" 2027 j¾Ifha § 

2 iy 7 fYa%Ks i|yd;a" 2028 j¾Ifha § 3 iy 8 fY%aKs i|yd;a" 2029 j¾Ifha § 4 

iy 9 fY%aKs i|yd;a" 2030 j¾Ifha § 5 fY%aKsh i|yd;a  m%d:ñl wOHdmk fY%aKs 

iy lksIaG oaú;Shsl fY%aKs i|yd kj úIhud,d y÷kajd §ug kshñ; h' lksIaG 

oaú;Shsl wOHdmk wjêfha isg kj bf.kqï l%ufõo we;=<;a fudähq, ilia lr 

we;s w;r bf.kqï,dNshdg wjYH  uÕ fmkaùu .=rejrhdf.ka n,dfmdfrd;a;= 

fõ' iajhx bf.kqu i|yd wjYH mßirh o fudähq, u.ska i,id we;' isiqkag 

wjYH ixl,am ms<sn| oekqu fuka u ,nd.;a oekqu Ndú; wjia:djkag fhduq 

lr isiq yelshd yd ,eÈhd Yla;su;a f,i ixj¾Okhg fuu fudähq, fnfyúka 

WmldÍ jk nj wmf.a úYajdihhs' 21 jk ishjig wjYH idlaIr;d" wka;¾mqoa., 

yelshd iy w.hhka ukd f,i Yla;su;a lsÍug fudähq, u.ska ,efnk bf.kqu 

bjy,a jkq we;'

kj ;dlaIKh Ndú;hg wjYH u. fmkaùu iEu fudähq,hl u olajd we;' 

;j o isiqkag ;ud <`.d lr.;a ld¾hh idOk iy wOHdmk wruqKq ms<sn| 

j úksúoNdjfhka we.hSug wjYH ;lafiare WmlrK ,nd fokq we;' iEu 

úg u kj yelshd" oekqu Ndú; wjia:djka i|yd fhdojñka h:d¾:jd§ 

bf.kqulg wjYH u. fmkaùu i|yd iEu fudähq,hla u b;d jeo.;a fõ'  

úfYaIfhka u fudähq, mdol bf.kqï l%ufõo ilia lsÍug uQ,slj lghq;= 

l< wOHdmk rdcH wud;HdxYfha ysgmq f,alï wdpd¾h Wmd,s fiaor iy cd;sl 

wOHdmk wdh;kfha ysgmq wOHlaI ckrd,a wdpd¾h iqks,a chka; kjr;ak 

yd uydpd¾h m%idoa fia;=x. hk uy;ajrekaf.a fiajdj b;d w.h lrñ' ;j 

o fuu fudähq, ilia lsÍfï § odhl jQ .=rejreka" .=re WmfoaYljreka" 

wOHlaIjrekaa fuka u rdcH iy fm!oa.,sl wdh;k ta ta lafIa;% Tiafia ÿka 

odhl;ajh fudähq, .=Kd;aul j by< uÜgulg kexùug fyA;= jQ nj b;d 

i;=áka u;la lrñ' ;j o fuu fudähq, mßyrKh lsÍfï § ,nk m%dfhda.sl 

w;aoelSï TiAfiA ,nd fok fhdackd b;du;a jeo.;a nj i|yka lrk w;r u ta 

i|yd Tng f.!rjfhka wdrdOkd lrñ'

fla' rxð;a m;auisß
ksfhdacH wOHlaI ckrd,a 
úoHd yd ;dlaIK mSGh



v

kj úIhud,d m%;sixialrK ms<sn| mqyqKqlrejka mqyqKq lsrSfï jevuq¿ i|yd uqøKh lrk ,oS'

WmfoaYkh" rpkh iy ixialrKh

WmfoaYkh		  (   

    

wëlaIKh       	 ( 

úIh iïnkaëlrKh ( 

f,aLl uKav,h	

wNHka;r        	 ( 

Ndysr			   ( 

uydpd¾h uxcq,d úodkm;srK ñh" 

wOHlaI ckrd,a" cd;sl wOHdmk wdh;kh' 

fla' rxð;a m;auisß uhd" 

ksfhdacH wOHlaI ckrd,a" 

úoHd yd ;dlaIK mSGh" cd;sl wOHdmk wdh;kh' 

tia' Yxuq.,sx.ï uhd" 

wOHlaI" 

f;dr;=re ;dlaIK fomd¾;fïka;=j" 

úoHd yd ;dlaIK mSGh" cd;sl wOHdmk wdh;kh' 

tï'tka'mS' uoaÿuf.a ñh"lÓldpd¾h" 

f;dr;=re ;dlaIK fomd¾;fïka;=j" 

úoHd yd ;dlaIK mSGh" 

cd;sl wOHdmk wdh;kh' 

mS'ã'ã ,laud,a uhd" iyldr l;sldpd¾h" 

ie,iqï yd we.hSï fomd¾;fïka;=j"

cd;sl wOHdmk wdh;kh' 

ì' fÊ mqIaml=udr uhd" .=re fiajh"  

r$lyj;a; uOH uyd úoHd,h" lyj;a;'

 

tï'î' uxcq, m%Nd;a chr;ak" 

.=re fiajh"  

f;dr;=re ;dlaIK yd ¥ria: wOHdmk" 

flakaøia:dkh" r$wdkkao ffu;%sh cd;sl 

mdi," n,xf.dv' 
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NdId ixialrKh ( 

msgq ieliqu	 ( 

tï' î' uxcq, m%Nd;a chr;ak" 

.=re fiajh"  

f;dr;=re ;dlaIK yd ¥ria: wOHdmk" 

flakaøia:dkh" r$wdkkao ffu;%sh cd;sl 

mdi," n,xf.dv' 

mS' tÉ' Y%shdks

udr$w;=re,sh u' ú'

wl=riai, 

B' wd¾' ksu,a fm%aul=udr

fcIaG l:sldpd¾h ^úY%dñl&

cd;sl wOHdmk wdh;kh

tï' î' uxcq, m%Nd;a chr;ak 

.=re fiajh  

f;dr;=re ;dlaIK yd ¥ria: wOHdmk 

flakaøia:dkh

r$wdkkao ffu;%sh cd;sl mdi,

n,xf.dv
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ye`Èkaùu

j¾;udk fõ.j;a" ;dlaIKh u; mokï jQ mßirh ;=<" f;dr;=re yd 

ikaksfõok ;dlaI‚l l=i,;djf.a wjYH;djh b;du;a oeä ù we;' 

fuu jeäÿr wOHhk fudähq,h isiqkaf.a 

Y%jH f.dkq yeisrúu  yd ixialrKh ms<sn| yelshdj-

ka iy l=i,;d jeä ÈhqKq lsÍu i|yd ks¾udKh lr we;s 

w;r" fõ.fhka mßKduh jk f,dalhl b,a,Sï i|yd Tjqka iQodkï 

lsÍu flfrys wjOdkh fhduq lrhs' fuu fudähq,h úúO bf.kqï 

fõ.hka iy ld,igykaj,g wkq.; jk iajhx wOHkh  lrk ,o 

bf.kqï l%shdldrlï iuÕska isiqkaf.a wjfndaOh iy;sl lsÍu i|yd 

ks¾udKh lr we;s Bg .e<fmk wNHdi iy ud¾f.damfoaY we;=<;a fõ' 

Tjqkaf.a wruqKq idlaId;a lr .ekSu i|yd iujhfia ñ;=rka iuÕ 

jev lsÍug isiqka Èßu;a lrñka iyfhda.S bf.kSu wjOdrKh flf¾' 

fuu fudähq,h f;dr;=re ;dlaIKh úIfhys iqúfYaIS úIh fldgia 

bf.kSug iy ;u oekqu ;jÿrg;a mq¿,a lsÍug Wkkaÿjla olajk 

isiqkag yeoEÍu ioyd ks¾udKh lr we;' fuu fudähq,fha wjidk 

mrud¾:h jkafka 21 jk ishjfia id¾:l;ajh i|yd wjYH 

l=i,;dj,ska isiqka ikakoaO lsÍu iy Tjqkaf.a mqoa.,sl bf.kqï 

wjYH;d fyd¢ka i,ld n,d Tjqkaf.a mßmQ¾K ixj¾Okhg iydh ùuhs'        

Bg wu;rj" fuu fudähq,fha we;=<;a l%shdldrlï iy wNHdi 

iïmQ¾K lsÍug myiqlï ie,iSug iy oekqu ;j ÿrg;a jeäÈhqKq 

lsÍug úúO fjí wvú iy hQáhqí ine| fuys wka;¾.; lr we;' 

wod< wka;¾.; ysñlrejkag udf.a yDohdx.u ia;+;sh mqo lrñ'

tia' Ikauq.,ska.ï uhd" wOHlaI"  

f;dr;=re ;dlaIK fomd¾;=fïka;=j
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kj úIhud,d m%;sixialrK ms<sn| mqyqKqlrejka mqyqKq lsrSfï jevuq¿ i|yd uqøKh lrk ,oS'

jeäÿr wOHhk fudähq,h  

iÔúlrK yd ùäfhda ixialrK wdos nyqudOH ixialrK l%shdj,sfha § 

Y%jH f.dkq yeisrùu w;HjYH ld¾hhls' Y%jH f.dkqjla" Y%jH 

ixialrKhg fmr Yío f.dkqj, we;=<;a Yíoj, úúO fjkialï 

fyd¢ka y÷kd .; hq;= h' tu ksid Yío y`ÿkd .ekSfï isg Y%jH 

f.dkqjla má.; lsÍu yd tajd úúO .=Kd;aul ú,dihka tla lrñka 

ixialrKh lsÍu olajd fuys lreKq olajd we;'

fudähq,h Ndú;hg Wmfoia 

•	 fuu fudähq,h tal, yd lKavdhï l%shdldrlï ;=<ska Tnf.a Y%jH f.kq 

yeisrúu iy Y%jH f.dkq ixialrKh ms<sn| l=i,;d ixj¾Okh lr .; 

yelsjk wkaoñka ks¾udKh lr we;'

 

•	 Tnf.a yelshdjka iy oekqu Tmakxjd,Sfï wruq‚ka wka;¾cd,h Ndú;fhka 

lreKq fidhd isÿ l< hq;= l%shdldrlï yd mejreï o fuys we;=<;a lr we;'

 

•	 fudähq, l%shd;aul lsÍfï § Tnf.a .=reNj;df.a iydh Tng ,efnk kuqÿ 

th ksis mßÈ yeoEÍu Tnf.a ld¾hhls'

 

•	 Èkm;d mka;s uÜgfï isÿjk we.hSï yryd wjidkfha Tnj cd;sl uÜgñka 

o we.hSug ,la flfrk neúka tu l%shdldrlï iy mejreï ksis mßÈ ksu 

lsÍu b;du;a jeo.;a jkq we;' 

•	 fuu l%shdldrlï yd mejreï ksu lsÍfï § Tn iy Tnf.a hy¿jka 

we.hSfï wjia:d o Tn fj; ,eî we;' tys § Tnf.a wjxlNdjh iy ksjerÈ 

;lafiarelrKh b;d jeo.;a fõ'

•	 tallhla wjidkfha § Tn ,nd .;a l=i,;d uÜgu .=rejrhd úiska we.hSulg 

,la lrkq ,nhs'



ix

kj úIhud,d m%;sixialrK ms<sn| mqyqKqlrejka mqyqKq lsrSfï jevuq¿ i|yd uqøKh lrk ,oS'

mgqk 

Y%jH f.dkq iu. jev lruq 						      1
y~g ijka fouq y~g ixfõ§ fjuq					     3 
Y%jH Wmdx. y`ÿkd .ksuq						      5

y~ má.; lruq  							       9

Y%jH ixialrKh lruq 						      16 
mrs.Kl ;dlaIKhg wod< uQ,sl ixl,am				    33



x
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fuu fudähq,h wjidkfha § Tng" 

	 Y%jH má.; lsÍu i|yd wjYH úúO ;dlaI‚l WmlrK 

Ndú;hg .ekSu 

	 má.; lsÍu i|yd iqÿiq mßirhla ks¾udKh lr .ekSu

	 má.; lrk ia:dkhl iodpdrd;aul yeisÍï mqreÿ lr .ekSu 

	 uDÿldx. Ndú;fhka Y%jH miqrla má.; lsÍu 

	 wjYH mßÈ má.; l< Y%jH miqrla ixialrKh lssÍu 

	 wdhd; lrk ^Import& ,o Y%jH miqr wjYH mßÈ ixialrKh 

lssÍu

	 úúO Y%jH f.dkq wdlD;s fj; má.; lrk ,o Y%jH miqre 

ks¾hd; lsÍu ^Export& 
	 Y%jH m:hla ießieÍug fláux h;=re ^Shortcut Key& Ndú; 

lsÍu 

	 Y%jH f.dkqjlg wu;r Y%jH fldgia tla lssÍu 

	 Y%jH ixialrK uDÿldx.hlg nyq Y%jH f.dkq wdhd; lssÍug 

	 úúO Y%jH f.dkq wdlD;s Ndú; lsÍu

	 Y%jH" Y%jH má.; lsÍu" Y%jH miqr" Y%jH f.dkq wdlD;sh" Y%jH 

m:h" iodpdrd;aul yeisÍï jeks uQ,sl ixl,am f;areï .ekSu

	 úúO ikao¾Nhka ;=< úúO mdßißl Yíoj, ,laIK iy 

jeo.;alu úYaf,aIKh lsrSu

	 tÈfkod Ôú;fha úúO wxY flfrys mß.Kl mdol 

úfkdaodiajdofha n,mEu ;lafiare lsrSu 

	 ms<sno yelshdj ,nd .; yels h'

bf.kqï m, 



jeäÿr wOHhk fudähq, 1

fï rg uf. rg - ud bmÿK rg

yefok jefvk rg - uf.a u ujq rg

 	   

	 .dhkh - ud,ks nq,;a isxy, uy;añh

ÿfõ" mqf;a æ

Thd," fï isxÿj wy, ;sfhkj fka o@ Thd, okakj o ;dlaIKh 

fhdod f.k má.; lsÍula lrmq ksid ;uhs fï iskaÿj wmsg wykak  

mqq¿jka fj,d ;sfhkafka'

fï isxÿj iq/ls j ;sfnk ksid wo jf.a u bÈß ld,j, §;a kej; 

kej; wykak mq¿jka'

Tng .S;h weiSug wjYH kï my; fï ine`osh (Link) fyda QR 
fla;h Ndú; lrkak' 

Y%jH f.dkq iu. jev lruq

Scan This

Type Thishttps://tinyurl.com/meratasong

fuu fjí wvúj,g wjika jrg m%fõY jQ Èkh (  2025-06-09 



jeäÿr wOHhk fudähq, 2

Thd, okakj o" wmsg mq¿jka fï iskaÿj má.; l<d jf.a u wfma 

lgy`v;a má.; lr .kak' ta ú;rla fkfuhs ÿfõ mqf;a" 

mßirhg ijka§, ,iaik l=re¨ .S; má.; lrkak;a mq¿jka'  

fïjd má.; lrkj ú;rla fkfjhs" wmsg mq¿jka mß.Klh 

fhdod f.k uDÿldx.hla Ndú;fhka wmg wkjYH fldgia bj;a 

lrkak' tfyu ke;s kï wjYH y`v fldgia fjk u má.; lr,d 

wfma y`v mgfha .=Kd;aul nj jeä lr .kak' ta wkqj .S; má.; 

lsÍu b;d ixlS¾K l%shdj,shla nj ys;d .kak mq¿jka fka o@  

ÿfõ mqf;a" wms fï fudähq,fhka bf.k .ksuqq.. wfma mß.Klfhka 

wmsg u y`v má.; lsÍula lr," wjYH fjkia lï lr .kak 

úÈy' 

	 QR (Quick Response) fla; QR scanner fhÿula u.ska 

úfla;kh (Decode) lr .; yels h' túg tys wvx.= 

o;a;j,g m%fõY úh yels h' fuys § wka;¾cd,fha we;s TkEu 

úäfhdajl fjí ,smskh QR fla;hla njg m;a lr we;' th 

mrsf,dalkh  (Scan) lsÍu u.ska Tfí iqyqre cx.u ¥rl:khg 

wka;¾cd, m%fõYh we;s kï tu o;a;j,g m%fõY úh yels h'  

	 Bg my<ska olajd we;s fjí ,smskh YouTube ys fijqï fldgqfõ 

h;=re ,shkh (type) lr tu o;a;j,g m%fõY úh yelsh'

	 fuu fuähq,h ;=< QR fyda YouTube link we;s kï tjdg 

m%fõY ùu i`oyd by; l%ufõoh wkq.ukh lrkak'   

Yíod.drhl .S;hla má.; jk wdldrh n,uq

https://tinyurl.com/audiostudiovideo

fuu fjí wvúj,g wjika jrg m%fõY jQ oskh (  2025-06-09

Tn okAkjd o@



jeäÿr wOHhk fudähq, 3

y`vg ijka fouq y`vg ixfõ§ fjuq

• mßirfha úúO Yío fjka lr y`ÿkd .kshs 

 ld¾hh idOk m%ñ;s

zy~Z hkq ikaksfõok udOHhla jk w;r wm mßirfha Ôj;a 

jk ish,af,da u y~g ixfõ§ fj;s'  

jeiai;a tlal tk y`vg Thd,d ijka §, ;sfhkj fka o@  

wr fyda fyda y`v''''''@  

ta;a ÿfõ mqf;a" 

	 ó ueiaikaf.a .=ï .=ï kdohg"  

	 l=re,a,kaf.a w;a;gq .ik y~g" 

	 uqyqfoa r< y~g"  

	 iq<Õg .ia fi,fjk y~g" 

	 l=re,a,kaf.a lsÑ ìÑhg 

Tn ljod fyda ixfõ§ j ijka § ;sfí o@ 

tfia u u,a fm;a;la msfmk y~lg  

ijka§ug Tn ljodl fyda is;=jd o@ oeka Tn mßirfha wefik 

fjk;a fujeks Yíohkag ixfõ§ ùug mqreÿ jkak' 

“Music is Organized Sound”
(Edgard Varese)

“ix.S;h ixúê;j ilia lrk ,o Yíohls”
(tâ.dâ jf¾ia)
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 tÈfkod Ôú;fha § Tng yd Tnf.a ñ;=rkag weiS we;s  ´ke u        

 Yío$y`v ñ;=rka iu. idlÉPd fldg ,ehsia;= .; lr mka;shg 

 bÈßm;a lrkak

						                   ^ñks;a;= 25 hs&

l%shdldrlu 1'1

m<uq jrg má.; lrk ,o Yíoh l=ula o@

wef,laiekav¾ .%eyeï fn,af.a m<uq ¥rl:k weu;=ug 

^1876& oYl follg muK fmr tkï 1850 .Kkaj, 

w.Nd.fha § th Edouard-Leon Scott de Martinville 
^tfvdaw¾â ,sfhdaka iafldÜ ä udákajhs,a& úiska meßisfha § fuh 

má.; lrk ,os' 

Tn okAkjd o@ 

 

https://tinyurl.com/oldsoundrecord

fï ms<sn`o jeäÿr úia;r i`oyd my; QR fla;h Scan 
lrkak'

fuu fjí wvúj,g wjika jrg m%fõY jQ oskh (  2025-06-09
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;rx. wdlD;sh ^waveform&
uDÿldx.hlg Y%jH f.dkqjla we;=¿ l< úg th rEmuh 

jYfhka fmkajkafka my; wldrfhks' th wms waveform 
fyj;a ;rx. wdlD;sh f,i y÷kajuq' fuys úoHd;aul miqìu 

Tng bÈß fY%a‚j, § úoHd úIh u.ska bf.k .; yelsh'

Tn okAkjd o@ 

Y%jH Wmdx. y`ÿkd .ksuq

• wxls; má.; lsÍfï Wmdx. y`ÿkd .ksuq

 ld¾hh idOk m%ñ;s

ÿfõ" mqf;a Thd, okakj o" Yíohla iajdNdúl j fyda lD;s%u 

j ks¾udKh l<dg" tu Yío äðg,a Wmdx.hlg we;=<;a 

lsÍug yd äðg,a Wmdx. Ndú;fhka ijka §ug wmsg úúO 

;dlaI‚l fuj,ï wjYH nj' 

jeäysáfhl=f.a o wdOdrh we;=j rEmjdyskS hka;%hl we;s Yío 

flfjksj, (audio ports) j¾K fjkia lï ksÍlaIKh lrkak'

fmr iQodku 
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	 .=re Wmfoia wkqj lKavdhï jkak

	 Tng ,nd fok Y%jH Wmdx. ms<sn| j lKavdhu iu. 

idlÉPd lr y÷kd .kak 

	 .=re;=ud fyda .=re;=ñhf.a iyh we;sj tu Wmdx. mß.Kl-

hg  ksjerÈj iïnkaO lrkak 

	 tu Wmdx.j, ld¾hhka ms<sn`o idlÉPd lrkak 

								        ^ñks;a;= 25 hs&

l%shdldrlu 2'1

wNHdih 2.1.2

my; olajd we;s ;dlaI‚l Wmdx. y`ÿkd .ksñka ta ta Wmdx.

fhka isÿjk ld¾hh olajkak' 

Wmdx.j, ku

..................................................................

.................................................................

ld¾hh

..................................................................

..................................................................
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wNHdih 2.1.2

Wmdx.j, ku

..................................................................

.................................................................

Wmdx.j, ku

..................................................................

..................................................................

ld¾hh

..................................................................

..................................................................

ld¾hh

..................................................................

..................................................................

my; tla tla Yío flfjksfha j¾Kh y÷kdf.k tajdg iïnkaO 

l< hq;af;a l=uk Wmdx.h oehs my; mo ,ehsia;=fjka f;dard 

ysia;ek u; ,shkak.

^iamSlrh$Yío m%;sodkh" uhsfl%daf*dakh" Yío wdodkh&

.......................... ............................ ...........................
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iajhx ;lafiarelrKh

;lafiarelrK ks¾Kdhlh

•	 Yío Wmdx. ksjerÈj iïnkaO lsrSu

Tng bgql< yels ld¾hhka bÈßfha we;s fldgqfõ —˜i<l=K 

fhdokak'

ld¾Hhka —˜i<l=K

1' Yío Wmdx. fudkjd±hs f;dard .ekSug    

   ug mq¨jks'

2' flfjksfhys j¾Kh wkqj flfjksh   

   l=ula±hs f;dard .ekSug ug mq¿jks'

3' flúksfhys j¾Kh wkqj iïnkaO l< 

   hq;= Wmdx.h l=ula±hs f;dard .ekSug 

   ug mq¿jks'

4' Yío Wmdx. kï lsrSug ug mq¿jks'

5' Yío Wmdx. mß.Klfha ksjerÈ 

  flfjkshg iú lsrSug ug mq¿jks'

—˜i<l=Kq .Kk

Tng ysñ ,l=Kq .Kk ''''''''' $5

ú
I
h
 l

r
eK

q

—˜ ,l=Kq .Kk 5 kï b;d fyd`ohs ^,l=Kq 5 hs&

—˜ ,l=Kq .Kk 4 kï fyd`ohs ^,l=Kq 4 hs&

—˜ ,l=Kq .Kk 3 kï wfmalaIs; b,lalhg 

wdikakhss ^,l=Kq 3 hs&

˜ ,l=Kq .Kk 2 kï ixj¾Okh úh hq;=hs
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y`v má.; lruq

• Yío ixialrK uDÿldx.hla Ndú;fhka y`vmghla má.;     

    lrhs'

 ld¾hh idOk m%ñ;s

wmg kej; kej; Yío weiSug kï tu Yío má.; l< (Record) 
hq;= h' w;S;fha § Yío má.; lsÍug,
	 • leiÜ mg (Cassette  Tapes)
	 • .%eu¾f*daka ;eá (Gramophone Disk)Ndú; lrk ,È'

j¾;udkfha § b;d by< .=Kd;aul Ndjhlska hq;= äðg,a má.; 

lsÍï isÿ lrk w;r" ta i`oyd má.; lsÍfï Wmdx.j,g wu;r j 

uDÿldx.hl iyh o w;HjYH fõ' 

Yío má.; lsÍug wjYH Wmdx.

	 •	 uhsl%f*dakh (Microphones)
	 •	 kdol (Speakers)
	 •	 biankqj (Headset/ Headphone)

3.1 .%eu¾f*daka3.2 leiÜ mg
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fmr iQodku 

my; i|yka 3'1 ls%hdldrlug wod< má.; lsrSu i|yd wjYH 

	 • Woeik is;=ú,a,la 

	 • mdi,a .S;fha mo fm<

	 • mKsúvhla fyda .S;hla

	 • ksfõokhla 

,shdf.k meñfKkak.

my; i|yka ud;Dld w;ßka Tn lKavdhug ,eî we;s ud;Dld-

jg wod< má.; lsÍu Voice Recorder/ Sound Recorder Ndú;f-

hka isÿ lr mka;shg bÈßm;a lrkak.  
	 WoEik ojfia is;=ú,a,

	 WoEik /iaùfï § jdokh lsÍu i|yd mdi,a .S;h 

	 úfõl ld,fha § uq¿ mdi,g u Y%jKh l< yels m‚úvhla 

fyda .S;hla

	 mdif,a ksfõokhla

l%shdldrlu 3'1

^ñks;a;= 50 hs&
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wekafv%dhsâ fufyhqï moaO;sfha Yío má.; lsÍfï fhÿï ^Voice 
Recorder apps) lsysmhla lsysmhla my; oelafõ.

Tn okAkjd o@ 

	 l%shdldrlu 3.1ys Tn lKavdhu úiska má.; lrk ,o Y%jH 

f.dkqjg kej; ijka fokak 

	 ta wkqj tys fodaI we;s kï tajd y÷kd f.k Yío má.; 

lsÍug mßirh l=uk wdldrfhka ilia úh hq;= oehs idlÉPd 

lr ,hsia;= .; lrkak

	 Yío má.; lrk ia:dkhla ;=< ms<smeosh hq;= wdpdrO¾u 

,ehsia;= .; lrkak

	 Tn lKavdhu fidhd .;a lreKq mka;shg bosßm;a lrkak

l%shdldrlu 3'2

^ñks;a;= 50 hs&
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Tnf.a oekqug 

 Yío má.; lsÍfï oS fhdod .kakd uDÿldx.hla y`ÿkd .ksuq

Voice Recorder/ Sound Recorder Ndú; lr Yíoh má.; lsÍu

• Tnf.a mß.Klfhys fijqï ljq¿fjys Voice Recorder/ Sound   
  Recorder f,i h;=re,shkh (Type) lsÍfuka Voice Recorder/ 
  Sound Recorder fj; m%fõY úh yels h'

• Voice Recorder fj; m%fõY jQ miq ,efnk w;=re uqyqKf;ys  
  (Interfac) o¾Ykh jk fuu whslkh (Icon) u; la,sla (Click)
  lsÍfuka Yíoh (Sound)má.; lsÍu (Record)wdrïN l<

  yels h'

•	 má.; lsÍu ;djld,slj k;r lsÍu (Pause) i|yd Pause 
fnd;a;u Ndú; l< yels h.

•	 má.; lsÍu w;r;=r, Pause lsÍfuka miq kej; má.; lsÍu 

wdrïN lsÍu i|yd Resume recording Ndú; l< yels h'

•	 má.; lsÍu wjika lsrSu ioyd Stop recording Ndú; l<       

yels h'
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•	 Yío f.dkqj .nvd ù we;s ia:dkh fidhd .ekSu má.; jQ Yío 

f.dkqfõ ku u; uQislfha ol=Kq fnd;a;u la,sla lsÍfuka ,efnk 

,ehsia;=fjka Open File Location hkak f;dard .; yels h'

fonia má.; lsÍfï § fkdfhla 

yeÕSfuka" fkdfhla iajrEmj,ska 

tu foni má.; lsÍug W;aidy 

l< yels h túg úúO w¾: tu 

fonig ,efí
  
  Wod(- —ug nv.skshs˜ hk jdlHh wdfõ.YS,S j"  ne.Em;a j iy       

         idudkH f,i WÉpdrKh lsÍu.

má.; lsÍula i`oyd iqÿiq mßÈ mßirh ilia lsÍu b;du;a jeo.;a jk 

w;r jdKsc uÜgfuka, wm úiska Yío má.; lsÍug" tajdg u ieliq 

YíOd.dr ;sfí' tajdfhys ndysr Yío we;=<g fkd wefik f,i;a" YíOd.

drh ;=< we;s Yío msg;g ldkaÿ fkdjk f,i;a ks¾udKh lr we;'  

fï YíOd.dr i`oyd  úúOdldrfha ;dlaI‚l l%ufõo Ndú; lrñka 

YíodrlaIs; (soundproof) lr ks¾udKh lr we;' tf,i ks¾udKh 

lr we;s YdíOd.dr ;=< wê;dlaI‚l uhsl%fmdak" úúOdldrfha 

Yío má.; lsÍfï hka;% ia:dms; lr we;s w;r u" fuu YíOd.dr 

Ndú;fha §  oeä f,i ms<ssmeÈh hq;= wdpdrO¾u moaO;shla  o we;.
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	 by; 3'2 l%shdldrlfuys § y÷kd .;a fodaI wju jk mßÈ 

mßirh ilid .kak'

	 l%shdldrlu 3'1ys Tn lKavdhu úiska má.; lrk ,o Y%jH 

f.dkqj kej; má.; lr mka;shg bÈßm;a lrkak

l%shdldrlu 3'3

^ñks;a;= 50 hs&

NASA wdh;kh úiska iQ¾hhdf.a Yíoh má.; lr ñksia Y%jK mr-

dihkag wkqj ilid we;' tu iqúfYaI Y%jH LKavhg ijka §ug my; 
QR fla;h fyda YouTube ine¢h Ndú; l< yelsh'

Tn okAkjd o@ 

https://youtu.be/CRu_hG3X3bI?si=Ld-x_yesFhSvanY5

iskud l¾udka;fha § Ndú; lrk—fYdÜ.ka uhsla˜ (shotgun mike)

fuu fjí wvúj,g wjika jrg m%fõY jQ oskh (  2025-06-09



jeäÿr wOHhk fudähq, 15

iajhx ;lafiarelrKh

;lafiarelrK ks¾Kdhlh

•	 Yío ixialrK uDÿldx. Ndú;fhka y`v má.; lsrSu

Tng bgql< yels ld¾hhka bÈßfha we;s fldgqfõ —˜ i<l=K 

fhdokak'

ld¾Hhka —˜ i<l=K

1' y`v má.; lsrSug iqÿiq Wmdx. 

   f;dard .ekSug ug mq¿jks'

2' y`v má.; lsrSug iqÿiq Wmdx.hla 

mß.Klhg iúlsrSug ug mq¿jks'

3' mß.Klh Ndú;fhka y`v má.; 

lsrSug iy we;sjk fodaI ksrdlrKh 

lsrSug ug mq¿jks'

4' y`v má.; lsrSug iqÿiq mßirhla   

ilid .ekSu ug mq¿jks'

5' y`v má.; lsrSug iqÿiq uDÿldx.hla 

f;dard .ekSug ug mq¿jks'

—˜i<l=Kq .Kk

Tng ysñ ,lqKq .Kk ''''''''' $5

—˜ ,l=Kq .Kk 5 kï b;d fyd`ohs ^,l=Kq 5 hs&

—˜ ,l=Kq .Kk 4 kï fyd`ohs ^,l=Kq 4 hs&

—˜ ,l=Kq .Kk 3 kï wfmalaIs; b,lalhg 

wdikakhs ^,l=Kq 3 hs&

˜ ,l=Kq .Kk 2 kï ixj¾Okh úh hq;=h

ú
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y`v ixialrKh lruq

• Y%jH ixialrK uDÿldx. Ndú;fhka wdkhkh (Import) 
    

lrk ,o Yío miqrla (Clip) ixialrKh lrhs'

 ld¾hh idOk m%ñ;s

Yío fyda y~ má.; lsÍfuka Y%jH f.dkq ks¾udKh lrhs' fuu  

Y%jH f.dkq" mß.Klh Ndú; lr ks¾udKh lsÍug;a" ixialrKh 

lsÍug;a Ndú; lrk uDÿldx." Y%jH ixialrK uDÿldx. kï fõ'

Y%jH ixialrK uDÿldx. (Audio Editing Software)

má.; lsÍug iy ixialrKh lsrSu i|yd fkdñ,fha Ndú; l< 

yels uDÿldx.j,g WodyrK lsysmhls'  

•	 AudacityPower 
•	 Sound Editor 	
•	 Music Editor Free
óg wu;r j Adobe audition jeks jdKssc jYfhka Ndú;hg .; yels  

uDÿldx. o we;.

má.; lsÍug wfmalaId lrk mKsúvh fyda ldrKh Tng 

fld;rï yqre mqreÿ fohla jqj o th meyeos,s j fmfkk mßos 

fld<hl ,shd .; hq;= h' tkï má.; lsÍug n,dfmdfrd;a;= jk 

mKsúvfha fyda lreKq we;=<;a w;a msgm;la Tn i;=j ;sìh hq;= h' 

ksjeros má.; lsrSula  i|yd w;a msgm;la ilia lr .ekSu

Tn okAkjd o@ 
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	 mka;sh lKavdhï follg fnfokak

	 m<uq lKavdhug ,enqK lú fm< .dhkh lrkak

	 fojk lKavdhfï YsIH YsIHdjka oEia jidf.k" tu .dhkhg 

fyd¢ka ijka fokak

	 m<uq lKavdhu .dhkh isÿ lrk w;r;=r tu lKavdhfuys 

u fjk;a YsIH YsIHdjka jßka jr ishqï Yío lsysmhla we;s 

lrkak ^.=rejrhdf.a Wmfoia mßÈ&

	 .dhkfhka wk;=rej fojk lKavdhu, m<uq lKavdhu .hk 

w;r;=r wkjYH Yío weiqKq wjia:d bosßm;a lrkak

	 fï wdldrhg fojk lKavdhu o .dhkh lrk w;r;=r m<uq 

lKavdhu tu .dhkhg fyd¢ka ijka § wkjYH Yío weiqKq 

wjia:d bosßm;a lrkak

l%shdldrlu 4'1

^ñks;a;= 50 hs&

Tn okAkjd o@ 

Y%jH miqrla ixialrKh lsÍu i|yd tys mj;sk wkjYH Yío ̂f>daIdj& 

fyd¢ka y÷kd .ekSug yels jk whqßka Tfí ijka yqre lr .; h;= 

w;r, ta i`oyd wjOdkh r`ojd ;nd .ekSug j. n,d .; hq;= h.
th, wkjYH Yío myiqfjka y`ÿkd f.k bj;a lsÍug;a 

.=Kd;aul Y%jH miqrla ks¾udKh lr .ekSug;a bjy,a fõ. 

fmr iQodku

	 mdif,a ld,fPao udreùu ksfõokh lsÍug WÑ; w;a msgm;la 

(Script) ilia lrf.k mka;shg meñfKkak. ^Tfí uõniska yd 

bx.%Sis niska&

Wod “fï wdrïN jkafka m<uq ld,fPaohhs” 
      “This is the beginning of the first period”
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	 ld,Éfþoh wjika ù B<Õ ld,Éfþoh wdrïN jQ nj yÕjk 

ksfõokh NdId foll Y%jH m:hla f,i Y%jH ixialrKh 

lsÍfï uDÿldx.hla (Audio Editing Software)  Ndú; lr 

má.; lrkak'

	 má.; lrk ,o Y%jH m:h (Audio Track)  Odjkh lr (Play)  
thg ijka fokak'

	 Tnf.a má.; lsÍu mß.Klfha .nvd (Save) lrkak'

	 Tnf.a má.; lsÍu mka;shg bÈßm;a lrkak'

l%shdldrlu 4'2

^ñks;a;= 50 hs&

my; m%Yakj,g ms<s;=re ,shkak

	 Y%jH f.dkq ixialrKh l< hq;= jkafka wehs@

	 ksoyia yd újD; fla;l (Free and Open Source Software) 
Y%jH ixialrK uDÿldx. folla kï lrkak'

	 Y%jH ixialrKh i|yd we;s jd‚cuh uDÿldx.hla kï 

lrkak'

wNHdih 4.2.1

Tnf.a oekqug 

Audacity Ndú;fhka Y%jH má.; lsÍu 

	 	 Audacity uDÿldx.h újD; lrkak

	 	 kj Layers .ekSu fyda File → New 
	 	 File → Save Project → Save Project
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Audacity uDÿldx.fhka Yío má.; lsÍfï § mßjyk fuj,ï ;Srej 

^Transport Toolbar Bar& Ndú; lrhs' fuu.ska Yío má.; lsÍu 

^Recording&" kej; Odjkh lsÍu ^Playback&" md,kh lsÍu iy 

jHdmD;sfha  ^wdrïNhg fyda wjidkhg& miq mig fyda bosßhg .uka 

l< yels h'

File → Save Project u.ska Audacity j,g muKla újD; l< 

yels f,i Audacity jHdmD;s wdlD;sfhka Y%jH iq/lSu isÿ fõ 
.aup ;s;a m%idrlh iu. (dot extention) fuu wdlD;shg wkqj 

;ekam;a lrkq ,nk f.dkq, ixialrKh i|yd fhdod .; yels h.

	 má.; lsÍu ^Record)
    Yíoh má.; lsÍu wdrïN lsÍug Ndú; lrhs'

	 keje;aùu (stop)
	 Yíoh má.; lsÍu fyda  Odjkh jk Y%jH miqrej k;r lsÍug 

Ndú; lrhs.

	 úrduh ^Pause)
	 má.; lsÍu fyda Odjkh jk Y%jH miqrej ;djld,sl j k;r 

lsÍug Ndú; lrhs. fojk jrg;a úrduh u; la,sla  lsÍu u.ska 
kej; má.; lsÍu fyda Y%jH miqrej Odjkh lsÍu wdrïN l< 
yels h.
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ld,Éfþo udreùug NdId lsysmhlska Y%jH LKavhla jdokh ùu

i|yd jeä ld,hla .; jk neúka m%Odk udOH NdIdfjka jdokh

ùug i,iajk f,i Tfnka b,a,d we;ehs is;kak. Y%jH ixialrKh

lsÍfï uDÿldx.hla Ndú;fhka Y%jH miqrejl fldgila bj;a lr

.=Kd;aul Y%jH f.dkqjla ks¾udKh lrkak.

•	 l%shdldrlu 4.2ys § ks¾udKh lr .;a Y%jH f.dkqj Audacity 
uDÿldx.h Ndú;fhka újD; lr .kak

•	 th Odjkh lr ^Play) fyd¢ka ijka fokak

•	 tys wvx.= NdId foll ksfõokh fjkqjg Tfí mdif,a m%Odk 

udOH NdIdfjka oelafjk ksfõokh muKla b;sß lr wfkla 

NdIdjg wod< Y%jH fldgi bj;a lrkak

•	 ixialrKfhka miq Tfí kj Y%jH m:h kej; Odjkh lr 

(Play) fyd¢ka ijka fokak

•	 ixialrKh lr .;a Y%jH m:h .nvd lsÍug ia:dkhla f;dard 

iqÿiq kula ,nd § mß.Klfha .nvd lrkak

l%shdldrlu 4'3

^ñks;a;= 50hs&

	 wjidkhg .uka lsÍu (Skip to Stop)	
	 Y%jH miqrefõ wjidkhg .uka lsÍug Ndú; lrhs.

	 wdrïNg .uka lsÍu ^Skip to Start&
	 Y%jH miqrefõ wdrïNhg .uka lsÍug Ndú; lrhs.

	 Odjkh ^Play&
	 má.; lrk ,o Y%jH miqrej Odjkh lsÍug Ndú; lrhs'
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fláux h;=re Ndú;fhka jev myiqlr .ksuq

	 h;=re mqjrefõ ^Keyboard& we;s Space h;=r, Y%jH m:h ^Audio 
Track&  Odjkh ^Play& fyda k;r lsÍu (Stop& i|yd fláux  

h;=rla (Shortcut Key& f,i Ndú; l< yels h.

	 Y%jH m:fha leu;s ia:dkhlska Odjkh wdrïN lsÍu i|yd f;aÍï 

fuj,u (Selection Tool) f;dard f.k Y%jH m:fha Odjkh wdrïN 

l< hq;= ia:dkh u; la,sla lr Odjk fnd;a;u ^Play Button& u; 

la,sla l< yels h.

	 Y%jH m:h ;=< l¾irh ^cursor)  jug fyda ol=Kg f.k hdug 

h;=re mqjrefõ jï fyda ol=Kq ÈYd h;=re (Left or Right Arrow 
Keys)  Ndú; l< yels h'

	 Y%jH m:fha fldgila f;aÍu

- uQislh Ndú;fhka 

•	wjYH fldgi f;arSug wdrïNl ia:dkh la,sla lrkak.
•	osiajk w;a ,l=K la,sla lr f.ku, f;arsh hq;= fldgfia 

wjidkh f;la weo uQislh uqod yrskak.		

- h;=re mqjrej Ndú;fhka

•	Yíom:fha wjYH fldgi f;dard .ekSug ol=Kq fyda jï ÈYd 

h;=re iu. Shift h;=r Ndú; lrkak.

Tnf.a oekqug 
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ijka §fï §" Y%jH f.dkqfõ fldgia u. yerSu (Skip) i|yd my; 

i|yka h;=re Ndú; l< yels h' 

	 l¾irh (cursor) ;;amrhla miqmig f.k hdug, jï ÈYd h;=r 
(Left Arrow Key) fyda fldud h;=r (") fhdod .; yels h. 

	 l¾irh ;;amrhla bÈßhg f.k hdug, ol=Kq ÈYd h;=r (Right 
Arrow Key) fyda Wvq fldud h;=r ^’& fhdod .; yels h.

	 l¾irh  ;;amr myla miqmig f.k hdug" jï ÈYd h;=r (Left 
Arrow Key)iu. Shift h;=r fyda fldud h;=r (") iuÕ Shift 
h;=r Ndú; l< yels h'

	 l¾irh ;;amr myla bÈßhg  f.k hdug, ol=Kq ÈYd h;=r (Right 
Arrow Key) iy Shift h;=r fyda ;s;a h;=r(’) iu. Shift h;=r 

Tnkak (Press).

	 iqrlsk ,o Y%jH f.dkqjla újD; lr .ekSu i`oyd Audacity 
     File → Open (Ctrl + O) ud¾.h fhdod .kak.

     Y%jH m:hl (Audio track) fldgila bj;a lsÍu

 

	 m<uq j f;aÍï fuj,u (Selection Tool) f;dard .kak.

	 bka miqj Y%jH m:fha bj;a l< hq;= ia:dkh u; la,sla lrkak'

	 bkamiq wjYH úia;rh olsk ;=re úYd,kh fnd;a;u (Zoom in) 
la,sla lrkak'
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	 Shift h;=r Tnd f.k isák w;r;=r bj;a l< hq;= fldgfia 

wjidk ia:dkfha l¾irh la,sla lrkak.
	 Edit Tool bar ys we;s Cut fuj,u fyda  Delete  h;=r o Ndú; l< 

yels h'

	 .=re Wmfoia wkqj lKavdhï jkak

	 .=re;=ud fyda .=re;=ñh úiska Tn lKavdhug ,nd ÿka .S 

mo fhdod f.k ixúOdkh ù fldgia jYfhka .S;h .dhkd 

lrkak'

	 Y%jH ixialrK uDÿldx.h u.ska th má.; lrkak ̂Record). 
	 .S;fha tl u fldgi kej; kej; fhfok wjia:dj, oS th 

tla wjia:djla muKla .dhkd lr má.; lrkak. 
	 th Odjkh ^Play& lr fyd¢ka ijka fokak'

	 .SS;fha tl u fldgi kej; kej; fhÈh hq;= ia:dk fyd¢ka 

y÷kd .kak' ^;rx. wdlD;sfha ^Waveform& wod< ia:dkh 

fyd¢ka y÷kd .kak'&

	 .S;fha kej; kej; fhfok fldgi msgm;a lr ^Copy& 
;rx. wdlD;sfha ^Waveform& wod< ia:dkj, ia:dk.; 

lrkak' ^Paste)  
	 tf,i ilid .;a kj Y%jH m:h iqrlskak (Save) 
	 kj Y%jH m:h ks¾hd; ^Export& lrkak'

	 Tn lKavdhu úiska ilid .;a Y%jH f.dkqj mka;shg 

bÈßm;a lrkak'

l%shdldrlu 4'4

^ñks;a;= 50hs&
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Tnf.a oekqug 

msgm;a lsÍu(Copy) iy we,ùu (Paste) Ndú;fhka Y%jH f.dkqjl 

wjYH fldgia ia:dk .; lsÍu

	 ixialrK fuj,ï ;Srej (Edit Toolbar) Ndú;fhka fyda fláux 

h;=re (Shortcut Keys) Ndú; lrñka .S;fha wjYH fldgi 

f;dard msgm;a lr (Copy/ Ctrl+C) .; yels h.

	 ;rx. wdlD;sfha" wod< .S; fldgi msgm;a lsÍug wjYH ia:dkh 

u; la,sla lsÍu.

	 ixialrK fuj,ï ;Srej (Edit Toolbar) Ndú;fhka fyda fláux 

h;=re  (Shortcut Keys) Ndú; lrñka Y%jH mgfha wjYH fldgi 

we,úh yelss h'  (Paste $ Ctrl+V). 

	 Y%jH mgfha fldgila fkd.e<fmk ia:dkhl mj;S kï" tu 

fldgi f;dard (Select), lmd (Cut) wjYH ia:dkhg we,úh 

(Paste) yels h. 

	 Y%jH mgh lemSug  Ctrl+X fláux h;=re Ndú; l< yels h.

fmr iQodku

f.dkq os.=jla (File extention) fyda f.dkq kdu os.=jla (File name 
extention) hkq uhsfl%dfid*aÜ úkafvdaia jeks fufyhqï moaO;sj, 

f.dkq j¾.h y`ÿkd .ekSug WmldÍ jkakls. fndfyda úg fuh 

;s;lska (‧) miqj wlaIr follska fyda ;=klska iukaú; fõ.
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	 .=re;=udf.a fyda .=re;=ñhf.a úiska Tng imhk ,o úúO f.dkq 

wdlD;sj,ska hq;= Y%jH f.dkq (File format) Y%jH ixialrKh 

lsÍfï uDÿldx.hg wdhd; (Import) lrkak'

	 tu f.dkq w;ßka Y%jH ixialrK uDÿldx.h i`oyd wdhd; l< 

yels f.dkq wdlD;s iy fkd yels f.dkq wdlD;s ,ehsia;= .; 

lrkak'    

l%shdldrlu 4'5

^ñks;a;= 50hs&

my; fldgqfõ i|yka lr we;s f.dkq wdlD;s w;=ßka Y%jH f.dkq 

wdlD;s f;dard ,shkak'

wNHdih 4.5'1

.pdf       	 .doc     	 .mp3      	 .wmv
	

.pptx    	 . midi   	  . wave     	 .xlsx

……………………………………………………………………………………
……………………………………………………………………………………

Tnf.a oekqug 

	 File → Import → Audio → wod< Y%jH f.dkqj fyda f.dkq  

f;dard .ekSu → Open fnd;a;u u; la,sla lsÍu'



jeäÿr wOHhk fudähq, 26

	 Tng ,nd fok ,o Y%jH f.dkqj Y%jH ixialrK uDÿldx.hg 

wdhd; ^Import& lr .kak'

	 ;rx. wdlD;sh ^Waveform& fyd¢ka ksÍlaIKh lrkak'

	 wdhd; ^Import& lrk ,o y~g ^Audio& ijka fokak'

	 Tfí Y%jH m:fhka ^Audio track& wdikak jYfhka ;;amr 10l 

fldgila fjka lr .kak ^Trim)
	 Tfí kj Y%jH m:h mÍlaId lrkak ^Test)
	 kj Y%jH m:h iqrlskak (Save)
	 kj Y%jH m:h ks¾hd; ^Export& lrkak'

	 ks¾hd; ̂ Export& lr .;a Y%jH f.dkqj Odjkh lr ̂ play& ijka 

fokak'

l%shdldrlu 4'6

^ñks;a;= 50hs&

Tnf.a oekqug 

	 WAV" MP2" MP3" FLAC hkq Y%jH f.dkq wdlD;s j¾. (Sound 
File Formats& lsysmhls. fuu f.dkq wdlD;sj,ska hqla; Y%jH 

f.dkq" Y%jH Odjk uDÿldx.hla ^Sound Play Software& u.ska 

Y%jKh l< yels h'

	 Y%jH f.dkqjla ks¾hd; ^Export& lr" Y%jH f.dkq Odjk (Play)
uDÿldx.hla (Sound Play Software) u.ska Y%jKh l< yels h' 

	 Audacity uDÿldx.h újD; lr tu ljq¿jg ^Window) Y%jH 

f.dkqj fyda f.dkq weof.k f.dia w; yeÍu ^Drag and drop&
	 Audacity whslkh ̂ icon& u;g Y%jH f.dkqj fyda f.dkq weof.k 

f.dia w; yeÍu ^Drag and drop&
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Y%jH m:fhka wjYH fldgi f;dard .ekSu

2' bka miq Edit→Remove Special →Trim Audio

Y%jH f.dkq ks¾hd; (Export) lsÍu'

1.	   File → Export →Export Audio 
2.	   f.dkqj ;ekam;a lrk ia:dkh f;dard f.dkqjg iqÿiq kula      

,nd oSu

3.	   wjYH f.dkq wdlD;sh (Save as Type) ;=<ska f;dard .ekSu

4.	   Save fnd;a;u la,sla lsrSu

5.	  bkamiq újD; jk Edit Metadata Tags ixjdo fldgqj               

Wmfhda.S lr .ksñka Y%jH ixOdrh ms<sn| úia;r we;=<;a 

fldg OK la,sla lrkak

Y%jH f.dkqjl wjidk fldgfiys y~ l%ufhka wvq lsÍu

(Fade out)
•	 Tn úiska ks¾udKh lr .;a Y%jH f.dkqj" Y%jH ixialrK  

uDÿldx.h u.ska újD; lr .kak'

•	 th Odjkh lr ^Play& fyd¢ka ijka fokak'

•	 Y%jH m:fha wjika fldgfiys ;rx. wdlD;sh ^Waveform&      

fyd¢ka ksÍlaIKh lrkak'

•	 Y%jH m:fha wjika fldgfiys y~ l%ufhka wvq lrkak.            
^Fade out)

•	 ;rx.fha isÿ jk fjkialï ksÍlaIKh lrkak'

•	 kej; Y%jH m:h Odjkh lr ^Play& fyd¢ka ijka fokak'

•	 kj Y%jH m:h iqrlskak ^Save&.
•	 kj Y%jH m:h ks¾hd; ^Export& lrkak'

   m%dfhda.sl mqyqKqj
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Tnf.a oekqug 

	 Y%jH f.dkqjl wjidk fldgfiys y~ l%ufhka wvq lsÍu     

(Fade out)

	 Skip to End fuj,u Ndú;fhka Y%jH m:fha wjidkhg .uka 

lsrSu

	 ;rx. wdlD;sfha wjidk ;;amr fol ;=k Tng fmfkk ;=re 

úYd,kh lsrSu

	 wjidk ;;amr tlla fyda follg muK fmr ;rx. wdlD;sh 

u; la,sla lsrSu

	 bkamiq Select → Region → Cursor to Track End (fmr la,sla lr& 

ia:dkfha isg ;rx.fha wjidkh olajd m%foaYh f;dard .ekSu 

(Select) bkamiq Effect → Fade Out ú,dih fhoSu

Fade Out lsÍug miqFade in lsÍug fmr

fmr iQodku

	 my; l%shdldrlu i`oyd Tn f;dard .kakd ud;Dldjg wod<j 

má.; lsÍug wjYH foa ^.S; LKavhla" .d:djla jeks& meyeos,sj 

fld<hl ,shdf.k tkak'
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	 mka;sNdr .=re;=ud fyda .=re;=ñhf.a wëlaIKh hgf;a mdif,a 

mßmd,k lghq;=j,g iydh ùu i|yd iqÿiq Y%jH f.dkqjla 

ks¾udKh lrkak'

	 mdif,a tla tla ld,Éfþo wdrïN ùfï § Odjkh l< yels 

mdi,g u wdfõ‚l jQ Y%jH miqrla ks¾udKh lsÍu'

	 mdif,a úfõl ld,fha § fyda mdi, wdrïN ùug m%:u Y%jKh 

ùug ie,eiaúh yels wOHdmksl jákdlulska hq;= Y%jH miqrla 

ks¾udKh lsÍu'

	 WoEik yd iji wd.ñl j;dj;a isÿ lsÍug iydh oelaùu i|yd 

Y%jH miqrla ks¾udKh lsÍu'

l%shdldrlu 4'7

^ñks;a;= 50hs&

Tnf.a oekqug 

Y%jH f.dkq fldgia lsysmhla tlg tla lrñka kj Y%jH f.dkqjla 

ks¾udKh lsÍu

	 wjYH Y%jH f.dkq lsysmh tljr Y%jH ixialrK uDÿldx.hg 

wdhd; ^Import& lr .; yels h.
	 File → Import→Audio →wjYH Y%jH f.dkq lsysmh tljr 

f;darkak'→ Open fnd;a;u u; la,sla lr .; yels h'
	 wjYH Y%jH f.dkq lsysmh tljr f;aÍug" h;=re mqjrefõ Ctrl 

h;=r Tndf.k wjYH f.dkqu; la,sla lsÍu'

	 h;=re mqjrefõ Shift h;=r Tnd f.k wjYH f.dkqu; la,sla 

lsÍu" wdÈh u.ska isÿ l< yels h'

	 kj Y%jH m:hla ,nd .ekSug" Tracks →Add New→Stereo 
Track Ndú; l< yels h'

	 tl ljqMjla ;=< o¾Ykh jk Y%jH m:j, ^Audio Tracks& 
fmfkk mrdih wjYH mßÈ ilid .; yels h'
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Tnf.a oekqug 

	 Y%jH m: ^Audio Tracks& bj;a l< yels h'

	 m: md,k uKav,h ^Track Control Panel& u.ska wkjYH .S;j, 

y~ ;djld,sl j ksy~ ^Mute& lr ;nd .; yels h'

	 m: md,k uKav,fha ^Track Control Panel& we;s, Close myiqlu 

Ndú;fhka wkjYH m: bj;a l< yels h.

	 Y%jH f.dkqjla fyda f.dkq i|yd ú,di ^Effects& fh§u.

	 Tn úiska fmr l%shdldrlïj, § ks¾udKh lr .;a  y~ mgh, 
Y%jH ixialrK uDÿldx.h u.ska újD; lr Odjkh lrñka ^Play& 
fyd¢ka ijka fokak.

	 Y%jH m:fha .e<fmk ia:dkj,g my; olajd we;s ú,di ^Effects& 
fhdoñka ;rx.fha iy yf~ys isÿjk fjkialï ksÍlaIKh lr 

.; yels h.
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	 Fade In ^Y%jH m:fha uq,a fldgig&

	 Fade Out ^Y%jH m:fha wjidk fldgig&

	 Speed ^Y%jH m:fha uOHfha f;dard .;a fldgilg&

	 Echo ^Y%jH m:fha uOHfha f;dard .;a fldgilg&

	 .S;h kej; Odjkh lr ̂ Play& fyd¢ka ijka § wjYH mßÈ ;j;a 

ú,di ^Effect& we;=<;a lrñka isÿ jk fjkia lï wOHhkh 

lr .; yels h

	 tf,i ilid.;a kj Y%jH m:h iq/lsh yels h (Save)
	 kj Y%jH m:h ks¾hd; ^Export& lr .; yels h

ú,di we;=<;a lsÍug fmr ú,di we;=<;a lsÍfukaa miq
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iajhx ;lafiarelrKh

;lafiarelrK ks¾Kdhlh

•	 Yío Wmdx. ksjerÈj iïnkaO lsrSu

Tng bgql< yels ld¾hhka bÈßfha we;s fldgqfõ —˜i<l=K 

fhdokak'

ld¾Hhka —˜i<l=K

1' y`v mghl wkjYH Yío y`ÿkd .ekSug   

   ug mq¨jks'

2' má.; l, y`vmghla .nvd lr 

   kej; Odjkh lsrSug ug mq¿jks'

3' Y%jH ixialrK uDÿldx.hla f;dard f.k 

y`v mghla újD; lsrSug ug mq¿jks'

4' Y%jH ixialrK uDÿldx.hla y`v mghla        

fldgiaj,g fjkalsrSug ug mq¿jks'

5' Y%jH f.dkqjla Y`jH ixialrK 

   uDÿldx.hlg wdhd; lsrSug ug mq¿jks'

6' ixialrKh l, y`vmghla .nvd 

   lsrSug ug mq¿jks'

7' yv mghl ;rx. wdlD;sh foi n,d 

yf`vys Wiamy;a lï y`ÿkd .ekSug ug 

mq¿jks' 

—˜i<l=Kq .Kk

Tng ysñ ,l=Kq .Kk ''''''''' $5

—˜ ,l=Kq .Kk 6 fyda Bg jeä kï b;d fyd`ohs ^,l=Kq 5 hs&

—˜ ,l=Kq .Kk 4 fyda Bg jeä kï fyd`ohs ^,l=Kq 4 hs&

—˜ ,l=Kq .Kk 3 kï wfmalaIs; b,lalhg 

wdikakhs ^,l=Kq 3 hs&

—˜ ,l=Kq .Kk 2 kï ixj¾Okh úh hq;=h

ú
I
h
 l

r
eK

q
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mrs.Kl ;dlaIKhg wod< uQ,sl ixl,am f;areï 

.ksuq

uDÿldx. 

^Software)
uDÿldx. hkq mß.Kl l%shd;aul lsÍug iy 

úfYaIs; ld¾hhka bgq lsrSug Ndú; lrk      

Wmfoia, jevigyka fyda o;a; iuQyhls

Y%jH ^Audio) Y%jH hkq idudkHfhka Yíohhs. th iïfma%IKh, 
má.; lsÍu fyda m%;sksIamdokh l< yels h

má.; lsrSu 

^Record)
uhsl%f*dakhla iy má.; lsÍfï WmlrK 

^m%;siu fyda ixLHdxl& Ndú;fhka Yíoh .%yKh 

lr .nvd lsrSu u.ska má.; l< yels h. th 

miqj ijka §ug fyda kej; ilia lsÍug yels h

Y%jH ixialrK 

uDÿldx. 

^Audio Editing 
Software)

Y%jH ixialrK uDÿldx. hkq ixLHdxl Y%jH 

f.dkq, yeisrùug iy fjkia lr ilia lsÍug 

ks¾udKh lr we;s mß.Kl uDÿldx.hls

Y%jH f.dkq 

wdlD;s ^Audio 
File Formats)

Y%jH f.dkq wdlD;s hkq ixLHdxl Y%jH o;a; 

.nvd lsÍfï l%u fõ 

Wod - MP3, WAV, AAC, FLAC, AIFF,...
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mrsYS,l 

w;=reuqyqK; 

^User Interface)

mßYS,l w;=reuqyqK;la ^UI&hkq mßYS,lfhl= 

iy mß.Kl moaO;shla, uDÿldx.hla fyda fhÿu-

la w;r wka;¾l%shd lrk uqyqK;hs. 

wdhd; lrk  

,o f.dkq 

^Import File)

f.dkqjla wdhd; lsÍu hkq tla f.dkqjlska o;a; 

fyda wka;¾.;h ;j;a jevigyklg, moaO;sh-

lg fyda f,aLkhlg f.k tau jk w;r tuÕska 

th Ndú; lsÍug fyda ieliSug yels fõ.

ks¾hd; lrk  

,o f.dkq  

^Export File)

f.dkqjla ks¾hd; lsÍu hkq ksYaÑ; f.dkq 

wdlD;shlg ^File Format) wkqj jevigyklska 

o;a; iq/lSu fyda mßj¾;kh lsÍu jk w;r, 
tuÕska th fjk;a jevigykl Ndú; lsÍug, 
fnod.ekSug ^share& fyda .nvd lsÍug yels fõ. 

ksoyia yd újD; 

uQ,dY% uDÿldx.   

^Free and Open 
Source Software 
/FOSS)

ksoyia yd újD; uQ,dY% uDÿldx. ^FOSS& hkq 

uQ,dY% fla;h újD;j iy fkdñf,a ,nd .; 

yels, ´kEu flfkl=g Ndú; l< yels, fjkia 

l< yels iy fnod.; ^Share& yels uDÿldx.hls. 

fláux h;=re 

^Shortcut Key)
fláux h;=re hkq mß.Kl h;=remqjrejl we;s 

h;=re ixfhdackhka jk w;r tajd ksYaÑ; l%shd 

fyda úOdkhka isÿ lrhs. fndfyda úg uQislhla 

Ndú; lsÍug fyda fukq yryd jev lsrSug jvd 

fõ.j;a fõ.
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